Scenario: Instructor’s Guide
This Guide discusses the following topics:
• Introduction
• What You Will Need To Use Scenario
• Instructional Level
• Instructional Objectives
• Scenario in the Classroom
• Commentary by the Student
• Reviewing Your Students’ Work
• About the Stage
• About the Costumes
Introduction
Scenario is a program that allows users to “block,” or design the actors’ movements in a scene
from one of Shakespeare’s plays. For each short passage, users create “frames” that show where
actors and props should be; they can then move from frame to frame individually, commenting on
each frame if they wish. The program creates individual files for each user and each scene as
required.
The finished file can then be submitted to an instructor, who in turn can comment both on each
frame and on the project as a whole.
What You Will Need To Use Scenario
Scenario is available for both PC and Macintosh computers. Files can be shared between both
kinds of computer.
Minimum System Requirements

PC
Windows 95 or better
Pentium 133Mhz
16Mb of RAM
Colour monitor (800 x 600 recommended)

Macintosh
System 8.0 or later
Power PC or better
16Mb of RAM
Colour monitor (800 x 600 recommended)

Instructional Level
The program can be used with students from the High School level to introductory College or
University.
Instructional Objectives
Scenario is designed to encourage students to become directors rather than merely readers of
Shakespeare. It will encourage them to see his plays as blueprints for action rather than flat
words on the page: like a score in music, the text of the play is waiting to be given life by
performance.
Many students will be familiar with Shakespeare on film, but the stage is very different from
film, and the Elizabethan stage very different from a modern stage. The program provides an
opportunity for students to learn about the limitations and strengths of a flexible acting space
that relied far more on language than on scenery or special effects. It is important to introduce
basic concepts of staging to students if they are to understand what they can achieve: the effects
of grouping, moving around the stage, gaining the power of centre stage, and the importance of
the way that an invasion of personal space can underline and heighten the effect of the language
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and action. Some sense of the kinds of “business” that can be inferred from the text is also
important.
Shakespeare’s actors were highly professional, and must have needed surprisingly little direction
in the production of plays. They seldom acted the same play two days following, and often put
on four or five in a single week. So they must have relied on many basic conventions for
movements, entrances and exits. Often the texts we have of the plays are vague about details of
staging. Even the few annotated promptbooks that survive from the period are sketchy, listing in
the margin only those items that may cause problems: child actors, musicians, and large props
(like beds) must be got ready.
The stage on which the action will take place is a reconstruction of the Globe Theatre, as
illustrated in Shakespeare’s Life and Times. As students use the program, they will become
familiar with the kinds of actions that were possible on the Elizabethan thrust stage with little
change of scene and with consequent opportunity for flowing action. They will realize both the
advantages and disadvantages of acting in the small upper stage, and the limited possibilities of
central curtain for “discovery” scenes where actors hide from each other.
A good introduction to the nature of the Elizabethan stage is the “book” of Shakespeare’s Life
and Times that discusses its history and structure. There is an example of the kind of choices that
are available in Scenario in the chapter “a scene performed.”

Scenario in the Classroom
There are several ways that Scenario can add to the students’ appreciation of Shakespeare.
• Students can work separately or in groups.
• They can be asked to choose different scenes, then to look at each other’s.
• They can all work on the same scene, then compare different solutions to the same
problems of production.
On “Directing” a Scene

One of the first things a director does when working on the production of a play is to “block” the
scenes, working out what the text implies in terms of movement across the stage, the groupings
of characters, the manipulation of props, stage “business” and so on. Scenario makes it possible
to do this by a simple process of selecting a short passage of the text, then selecting characters
and props from menus, and dragging them to the appropriate place on the stage. In this way,
students can create a series of frames, as they work through the scene. Students can then review
or edit the frames they have created.
Blocking is one of the first steps in creating an actual performance: the actors themselves flesh it
out in rehearsal. For this reason, the characters in the plays are represented as stylized images
rather than fully formed images, in order to emphasize that the program is designed to sketch the
actors’ movements, rather than to create a full animation of the scene. While the program uses
some of the tricks of computer games to activate the students’ interest, it is intended to focus on
the conditions of the early stage rather than the tricks of the modern computer.
Texts and characters from three frequently-taught tragedies are provided so that they can choose
which play you want to direct. The texts retain the often cryptic and uninformative stage
directions of the originals so that students should be encouraged to uncover the many hidden
clues in the words as to where actors move, who they are talking to, and so on. The limited
number of stage directions in the originals means that the director of Shakespeare has to work
harder than the director of many modern plays to figure out what is happening on stage;
correspondingly, however, there is greater freedom in interpretation.
Scenario:Instructor’s Guide

page 2.

Students should be aware that this is not an animation program: because it is a tool for blocking
the scene, the characters are stylized, and have only a limited number of positions available. Each
frame, however, has a text window for entering additional comments, so students can be
encouraged to explain why they make choices, and what additional instructions they might give
their “actors” in terms of action, gesture, tone of voice, and so on. The result is that students are
focused more on the questions that arise from actually staging the play, rather than creating a
computer animation of it.
Preparing Students for the Assignment

It is a good idea before the students begin to take a scene as an example and to go through it in
class in some detail, discussing the various problems the actors and producer need to solve before
they can put on a compelling performance. Depending on the scene the instructor chooses, the
problems may include:
• Entrances and exits. The need to get characters on and off stage smoothly, using the two
main doors, and the third entrance in the middle if necessary.
• Contrast. The need for a contrast between moments of movement and stillness as the
mood of the scene changes.
• Who is talking to whom? This is especially important in scenes with several characters.
Often one needs to prepare a conversation by drawing the characters apart before they
begin to speak, so the student will need to look through the whole scene carefully before
beginning.
• Stage business. Often there are hints in the text that suggest action of some kind; at
other times one needs to generate interest or make ideas more explicit by the use of
movement or props.
• Sound Effects. The program offers a limited number of sound effects. It is important to
decide how often and how obtrusively they might be used.
• Costumes. Students cannot change the costumes in the play, but they can be asked to
comment on the way the chosen costumes make some decisions about character—and
they may indicate that they would choose a different emphasis.
In each case, the students can indicate why they have made the choices they have, by adding
detailed stage directions to the text, or by using the Comment window that is available on each
frame as it is edited.
Commentary by the Student
Production Decisions

Scenario allows students to comment on the production as a whole, and on each frame
individually. These features can be used in different ways.
• The general comment, available from the View menu (Project Info), can be used to give
an overview of the scene. If students are asked to comment on their own production, they
will be encouraged to think about their decisions, and to justify which of various
alternatives they choose. They can be asked to explain what they think are the most
important actions in a scene, for example.
• The passages that the student selects for each frame can be modified by adding more
detailed stage directions, indicating the tone of voice the characters would use, gestures
they would make, and so on
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•

Comments on individual frames can be used to explain such things as why a prop is used,
or why a character turns away from the speaker. A special window for comments opens
when the student clicks on the Notes button, or selects Notes from the View menu.

Submitting a project for review

Students can submit projects by attaching their file to an email message, or by copying it to disk
and handing it in. Files are reasonably compact, and a student (the Director) can work on a
different kind of computer from the Reviewer. Remind your students to create a project name
that is informative and includes some form of their name: it can be confusing indeed to get half a
dozen assignments all called “Hamlet scene 2.shk.”
Reviewing Your Students’ Work
When you review your students’ work, you will open the files you receive from them, and the
program will recreate their work for you to see.
From the Options menu, select the item Select Mode. You will see a dialogue box that will
enable you to select Reviewer (it's a good idea to click also on the check box so that the program
remembers that you are reviewing when you have a batch of assignments to mark). Once you are
in Review mode, you will be able to click on the button at the bottom of the stage that brings up
a separate window into which you can type comments on individual frames.
To see the student’s overall comment, and to insert your own summary response, from the View
menu select Project Info: you will see a window that includes space for both summary
comments. This is a good place to insert the student’s grade, as well as your overall comment,
since it the first place the student will look when opening the file that you send back to them.
(Alternatively, students could use this feature to comment on each other’s work, asking
questions or making suggestions (it would be a good idea in this case to give the students copies
rather than originals, since there is always the risk of accidentally moving characters).
You will find that you can “page” through the frames, looking at the student’s comments on each,
and in turn commenting in the Review window if you have suggestions or notes of
encouragement.
Save the project (preferably with a new name); it is now ready to send back to the student so
that he or she can see all you have said.
About the Stage
The graphic for the stage is based on the design of the New Globe in London, which in turn is
based on extensive research into the documents that tell us about Shakespeare’s theatre. You can
visit their site to see the background of research at <http://www.reading.ac.uk/globe>, and can
explore the section of Shakespeare’s Life and Times that looks at the same evidence.
One possibly surprising quality of the reconstruction of the Globe is its ornate quality, yet there
are contemporary descriptions of the theatre that indicate very clearly that the acting company
created a lavish and luxurious appearance as part of the sense of holiday that the theatre inspired.
The two main doors at the rear of the stage are perhaps the most important device in the shaping
of scenes acted on it. Actors can enter from one door while those from the previous scene are
exiting from another (see the sample scene created as part of the Life and Times). The central
curtained entrance in the middle of the rear wall was probably less often used. It was the
“discovery-space” where Polonius hides when he is eavesdropping, or where Romeo hides from
his pursuers after the masque where he meets Juliet. The curtain can be opened or closed.
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The two pillars on the stage, holding up the roof above it, can also be used for overhearing, or for
other occasions when characters withdraw from the action; characters can be moved behind the
pillars.
The “balcony” was probably partly used by high-paying spectators, with the central area part of
the acting space when needed. In Romeo and Juliet, Juliet appears from a “window” rather than a
balcony (the term “balcony scene” developed in the Victorian period when stage sets were
elaborate and romantic). The upper level was also used for scenes where characters appear on the
“walls” of a castle or city. In Scenario, the whole upper level is available for characters, who will
appear to be behind the railing when they are placed there.
The roof of the stage was called the “heavens” and was probably decorated with images of the
major constellations; in this reconstruction the design is kept deliberately simple so that it
distracts less from the characters on stage. The texture of the stage itself is designed to look like
the rushes that were strewn there to reduce the sound of footsteps on the wooden surface of the
stage.
The art work for the image of the Globe stage was created by Chris Chong.
About the Costumes
An interesting topic for discussion with your students is the extent to which costume will change
how we respond to a play. There are some excellent examples of variations in costume and
setting in recent films of Shakespeare; the Renaissance costuming of Zeffirelli’s 1968 Romeo and
Juliet contrasted with the very modern setting of Baz Luhrmann’s 1998 film; the medieval
costuming of Zeffirelli’s Hamlet (starring Mel Gibson) contrasted both with Kenneth Branagh’s
nineteenth-century setting, and the recent Almereyda film with Ethan Hawke, set in very modern
New York. Scenario offers three periods in the three plays: Romeo and Juliet is costumed in
Italian medieval / early Renaissance style; Hamlet in full Renaissance costume (implying that
Shakespeare’s company would have used what then was modern dress), and medieval Scottish
costume for Macbeth.
The evidence from Shakespeare’s time is that they would have used a rather eclectic mix of
costume. The early sketch of a performance of Titus Andronicus suggests that the central
characters would have been costumed in something approximating historical costume (in this case
Roman), while subordinate characters would have worn their usual modern (Renaissance)
costume. The reason for this is clear enough: economy. It would have been simply too costly to
have provided full period costumes for all actors. Only the extravagant and expensive
performances of masques at Court would have involved the creation of special costumes for all
performers.
In the discussion above, I pointed out that the characters—and their costumes—are stylized
rather than realistic, in order to focus attention on the activity of “blocking” the scene as it might
have been on the original stage, rather than creating a modern computer animation.
The design of most of the costumes is based on those in the book of Renaissance costumes by
the Italian Cesare Vecellio (Vecellio’s Renaissance Costume Book. New York: Dover
Publications, 1977).
Hamlet

Although Hamlet is set in early medieval Denmark, the costumes chosen for this production are
those of Shakespeare’s time. The probability is that this is how Shakespeare’s company would
have staged it. Shakespeare’s early Denmark coexists with the much later University of
Wittenberg where Hamlet studies, and the clearly articulated conflict between Christian and preChristian views of revenge in the play set it in an intellectual and religious climate much closer to
Shakespeare’s day than the original story.
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Hamlet is dressed in black as he is still in mourning, and refers to his “inky cloak.” The Ghost is
in armour, as described by Horatio, and Horatio is shown as if he were studying for the Church.
The text is not specific on this point, but it suits his character, as he is always on the fringe of the
action not in the centre.
Romeo and Juliet

The general period of the costumes in Romeo and Juliet is early Italian early Renaissance. Thus
the young male characters wear tights rather than breeches; the intention is to emphasize their
youth. Servants for the Capulets and Montagues are essentially the same figures with different
“liveries” or uniforms; they are apparently opposed to each other, but behave in the same
manner, so are made to look alike.
Macbeth

Traditional Scottish dress has changed little over the years, so most characters wear kilts,
sporrans, and many of them carry staves. The witches are not taken from the contemporary
sketch in Shakespeare’s source (see the section in the Life and Times), where they appear like
rather elegantly dressed ladies. It is clear that Shakespeare imagined them very differently.

¶
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